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Advanced Layer Styles 

In this lesson, we’re going to take a deeper look into layer styles. There is a separate 
lesson that covers the essentials of layer styles and you might want to visit that les-
son before moving on to this one, which covers more intermediate and advanced 
features. Note that the terms “Layer Style” and “Layer Effects” are often times used 
interchangeably, but to be specific, the layer effects refer to the individual effects 
(Stroke, Outer Glow, etc.) and the layer style refers to the collective result of all the 
effects applied to a layer. 

The Fill setting

There might be instances where you want to keep the look of a particular layer style 
but not keep the contents of the layer that it’s attached to. The Fill setting allows us 
to hide the contents of the layer while keeping the layer styles at full opacity. 

The Fill setting is located at the top of the Layers panel, right under the Opacity 
setting. The Opacity and Fill settings are similar, but there’s an important differ-
ence. When you lower the opacity of a layer, the entire layer (including any layer 
styles attached to it) will become more and more transparent. When you lower the 
Fill setting, the contents of the layer will lower in opacity but the layer styles will re-
main completely visible. In the video example image, we have some text that has a 
Stroke, Inner Shadow and Drop Shadow applied. When we lowered the Fill setting 
to zero, the pixels making up the word “air” disappeared but the outline created by 
the stroke and the shadows still remained visible. 

LEFT: Here is the text layer with various layer effects added. CENTER: The opacity of the lay-
er is lowered to 20%. RIGHT: The Fill setting is lowered to 0% and you can see that the layer 
effects are still visible. 
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Outer Glow

The “Layer Style Essentials” lesson did not cover all of the different styles, so we 
will cover the rest of them here. The Inner Glow and Outer Glow layer styles are two 
of those. To add layer styles to a layer, make sure the layer is active and then click 
on the FX icon at the bottom of the Layers panel. This will bring up the Layer Styles 
pop-up menu. We’ll access this menu and choose Outer Glow. The Layer Style dia-
log will appear and it will display the settings for the Outer Glow layer style. 

The Outer Glow style will create a glow that extends out on all sides of the layer. 
This is different from one of the shadow styles, which extend out at one angle. We 
can control how far it extends by moving the Size slider. The Spread slider then 
determines how much of the glow is solid before it starts fading out. The Opacity 
slider will determine how strong the glow should be. If you drag this slider far to the 
left, the glow will be very minimal and hard to see. If you drag this shadow to the 
right, it will be much more prominent. 

The Outer Glow layer style is being applied to the “air” layer above. By default, the Outer 
Glow layer effect uses a blending mode of Screen (circled), which is only capable of  
lightening things.
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The Noise setting is something to pay attention to if the layer you are adding the 
glow to is going to be placed over a photo layer. Moving this slider up will make it 
so the edge of the glow is not a perfect edge. Instead, it will have some variability 
in the form of noise. This will make the glow look more realistic when placed on 
top of a photographic background. I keep the Noise slider at a low setting of 10-12. 

There are also some settings under the Quality category at the bottom, and these 
will be covered more later because they are more useful when working with some 
of the other layer styles. In general, though, the Jitter setting will randomize the ef-
fect and the Contour setting will make the transitions vary in different ways instead 
of creating a consistent transition.  

The Outer Glow layer style defaults to a blending mode of Screen, which is a mode 
that is only capable of brightening things. (The blending mode menu is at the top 
of the Layer Style dialog.) If you ever wanted a dark glow instead of a light one, you 
could click on the color swatch in order to call up the Color Picker. Select the dark 
color and click OK. Then, you will need to change the blending mode because the 
default blending mode (Screen) will not allow any dark colors to show up. Instead, 
change the blending mode to one that darkens things, such as Multiply mode. 

To create a dark Outer Glow, like the one shown above, you will need to set the color swatch 
to a dark color and set the blending mode menu to one of the options that darkens things.
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Inner Glow

The Inner Glow layer style is very similar to the Outer Glow style. The only differ-
ence is that the glow will appear on the inside edge of the layer instead of the 
outside edge. Looking at the settings for the Inner Glow effect, you will see that 
they are similar to those for the Outer Glow style. The Size slider determines how 
far the glow extends into the center of the layer. The Choke slider will determine 
how much of the glow will be solid before it fades out. (This is similar to the Spread 
slider in the Outer Glow settings.) 

At left, the Inner 
Glow effect is 
being applied and 
we are varying 
the Choke slider, 
which determines 
how much of the 
glow will be solid 
before it fades 
out. In the top 
screen shot, the 
Choke slider is set 
to 4. In the lower 
screen shot, the 
Choke slider is set 
to 36.
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When it comes to the Inner Glow style, you have two choices as to where the glow 
should appear. It can extend in from the edges of the layer or it can start in the 
middle and extend outward. This setting can be determined by clicking between 
“Center” and “Edge” Source options (near the center of the dialog box). 

Bevel & Emboss

We discussed the Bevel & Emboss effect in the lesson on layer style essentials, and 
here we’re going to talk about additional settings within this effect. When you open 
the Bevel & Emboss settings, you’ll notice that the dialog will remember all of the 
last settings you used with the effect and those settings will still be in place. At the 
bottom of the dialog, there are two but-
tons. Clicking the “Reset to Default” but-
ton will restore all of the Bevel & Emboss 
options to their default settings. Clicking 
the “Make Default” button will take the 
current settings and make those the de-
fault settings. 

The Source setting (above) 
determines whether the Inner 
Glow extends inward from 
the edges of the layer or out-
ward from the center of the 
layer. The two variations are 
shown at left.

At the bottom of the Layer Style dialog, 
there are two options that allow you to revert 
the effect to its default settings or take the 
current settings and make them the defaults. 
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Contour & Texture  On the left side of the Layer Style 
dialog, there are two options indented below the 
Bevel & Emboss heading: Contour & Texture. When 
the Texture check box is turned off, it assumes that 
you’re applying the Bevel & Emboss effect to a flat 
surface. When you turn this check box on, it is going 
to activate a “bump map,” which is going to assume 
that the surface is three-dimensional. Different set-
tings will appear on the right side of the dialog, in-
cluding a Pattern menu that allows you to choose a 
pattern that defines the characteristics of the sur-
face. When it comes to the patterns, it thinks of the bright areas of the pattern 
as the areas that are close to you and it thinks of the dark areas as parts that are 
farther away from you. The Scale slider will make the pattern larger or smaller and 
the Depth slider will make the pattern feel deeper or shallower by brightening and 
darkening the highlights and shadows. The Invert setting will take the areas that 
are raised and make them appear recessed, and vise versa. 

The Contour & Texture settings 
are part of the Bevel & Emboss 
effect and can be found on the 
left in the Layer Style dialog.

Here, we are choosing a pattern within the Texture settings of the Bevel & Emboss effect.
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The Contour setting on the left side of the dialog will allow you to determine the 
shape that’s on the outside edge of the Bevel & Emboss effect. Turning on the Con-
tour check box will bring up a few different options on the right side of the dialog, 
including the Contour menu, which allows you to determine the shape of the curve 
that is created by the Bevel & Emboss effect. Alternatively, you can create your 
own contour shape by clicking directly on the contour preview thumbnail to call 
up the Contour Editor. Use this curve to create any shape you’d like by clicking and 
dragging on the different areas of the curve. If you create a contour effect that you 
like and want to use again, you can save it as a preset by clicking the Save button 
to the right of the contour curve. After saving a preset, it will appear within the 
Contour menu. 

Above, we are using the Contour menu 
within the Contour settings in order to 
create the shape of the Bevel & Emboss 
edge. At left, we clicked on the Contour 
thumbnail in order to call up the Contour 
Editor and we are moving the curve to 
create a custom contour.
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When the Contour menu is expanded, you’ll see a little gear icon to the right of 
the preset thumbnails. Click this icon to access a menu that will allow you to Save 
Contours or Load existing contours. 

Gloss Contour There is another option within the Bevel & Emboss settings that 
allows you to determine the contour of the edges and this is the Gloss Contour 
menu. You need to be looking at the regular settings for the Bevel & Emboss effect 
and not the settings for the Contour or Texture effects. To get back to the Bevel & 
Emboss settings, click on the name “Bevel & Emboss” on the left side of the Layer 
Style dialog. The Gloss Contour determines how shiny the object on the layer is and 
therefore how the light would reflect off of it in various areas. Here, you will find the 
same contour options that were available in the Contour menu. 

How to apply the same style more than once to the same layer

Let’s say that you want to apply a layer style (or 
styles) to the same layer more than once. This isn’t 
as straightforward as it might sound. After applying 
the styles, if you go back to the Layer Style menu 
and choose the style[s] again, it will simply bring 
you back to the settings for the effect that is already 
in place so that you can tweak them. If you want to 
apply more than one instance of an effect, click on 
the little plus icon [ + ] to the right of the effect’s 
name on the left side of the Layer Style dialog. Note 
that you will only see the plus icon for five of the 
available layer styles. For the others, you will only be 
able to apply one instance of the style to the layer. 

In the video example image, we want to add more than one stroke effect to the 
layer. We already have a black stroke and we will click on the plus icon to the right 
of the name “Stroke.” When we do this, another instance of the Stroke effect will 
appear in the list of styles on the left side of the dialog and we can control the two 
different strokes independently of one another. 

To add a second instance of an 
effect that you already have ap-
plied, click on the little plus icon 
to the right of the effect name in 
the Layer Style dialog.
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Note that there is a stacking order when you have 
more than one instance of the same effect. In our ex-
ample, we created a black stroke as the underlying 
one and we had to drag the Size slider up, making 
the stroke thicker so that it could be seen beneath 
the second stroke that we created, which is yellow. 
You can change the stacking order of the effects 
by clicking on the name of an effect and then using 
the up and down arrow icons at the bottom of the 
effect list. 

I will sometimes create different variations of an ef-
fect, turning on the check box for only the variation 
I want to use at the time. 

To remove one of the layer styles/effects, click on 
the style to make it active and then click on the trash 
can icon at the bottom of the effects list. If you de-
leted an effect and want to get it back, click on the 
FX menu in the bottom left corner of the dialog and 
then either choose the name of the effect you want 
to bring back or choose to Show All Effects. 

Above, we have created two instances of the Stroke effect. The first stroke has a larger size 
and is black. The second, overlying, stroke has a smaller size and is yellow.

Change the stacking order of an 
effect by using the arrow icons. 
Delete an effect by clicking on 
the trash can icon.
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Copy a layer style from one layer to another

After you have created a layer style for one 
of your layers, you might want to apply 
that style to one or more of your other lay-
ers. To do this, right-click on name of the 
layer (with the style you want to copy) and 
choose “Copy Layer Style” from the pop-
up menu. Then, right-click on the name of 
the layer you want to paste the styles to 
and choose “Paste Layer Style” from the 
pop-up menu. You can copy the style to 
multiple layers at once by selecting all of 
the layers before right-clicking to access 
the pop-up menu and choosing “Paste 
Layer Style.” Note that you can also do this 
between documents. You can copy a layer 
style from one document and paste it into 
a layer that is contained within a different 
Photoshop document. 

Applying a layer style to multiple layers as a whole

In the video example document, we copied a layer style to a series of layers that 
formed a square made of interlaced bars. Each bar was a separate layer. When 
we pasted the layer style, it was applied to each layer individually so each bar ap-
peared to be separate from the other bars (as in not connected). But what if we 
wanted to apply the style to the shape as a whole? That would make it look like we 
had one object with a style applied instead of several different objects (bars) with 
a style applied. In other words, when applying the layer style, it would treat it as if 
those layers had been combined together before applying the effect. To do this, we 
need to use folders, also known as layer groups. 

Here, we’re pasting a layer style onto all 
of the selected layers. We right-clicked on 
one of the selected layer names and are 
choosing to Paste Layer Style. 
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You’ll first need to place all of the layers that 
make up the shape inside of a group. To place 
layers into a group, select more than one layer 
in the Layers panel and click the folder icon at 
the bottom of the panel. This will create a new 
group with all of the selected layers placed in-
side of it. Then, Right-click on the name of the 
folder and you will get the same pop-up menu. 
When you choose to “Paste Layer Style,” it will 
act as if the contents of the folder have been 
merged into one piece and then it will apply the 
style to that piece. 

Above, we pasted the same layer style onto each individual bar layer. The resulting image 
looks like several objects that are not connected to each other. 

To place multiple layers inside of a 
folder, or layer group, make sure all 
of the layers are selected and then 
click the folder icon at the bottom of 
the Layers panel.
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Scale Effects

When you copy a layer style from one layer to another, it’s going to use all of the 
same settings for the individual effects that make up the style, regardless of the 
size of the layer. This means that if you copy a layer style from a really small layer 
and paste it onto a really large layer, the effects will not scale accordingly. For ex-
ample, if you copied a layer style that was created with a stroke effect from a layer 
that was very small and then pasted it onto a layer that was very large, the stroke 
would look much thinner on the large layer than it looked on the small layer. If you 
would like to scale the effects of the layer, click on the Layer menu at the top of the 
interface and choose Layer Style > Scale Effects. A small dialog will appear where 
you can use the Scale setting to scale the effects larger or smaller. This slider will 
change all of the effects applied to the layer. 

Above, we pasted the layer style onto the folder/group instead of each individual layer.
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You will find a similar option when you use the Image Size dialog to resize your 
document. (The Image Size feature can be found under the Image menu at the top 
of the interface.) After specifying the size settings within this dialog, click on the 
little gear icon in the upper right corner of the box. This will give you the option to 
Scale Styles. When the check box is turned on, it will scale all of the layer styles to 
match the resizing of the document. 

Create Layer from a layer style

There will be instances where you want to do 
something to a layer style that is not possible 
within the Layer Style dialog. For example, 
let’s say you wanted to take a drop shadow 
and add a rippled effect to it. When this is the 
case, you can start by taking the layer style 
and turning it into its own, individual layer. 
With the appropriate layer active, click on the 
Layer menu at the top of the interface and 
choose Layer Style > Create Layer. This will 
separate any layer styles applied to the layer 
and place them on their own layers so that 

LEFT: We’re using the Scale Layer Effects setting to scale all of the effects applied to the ac-
tive layer. RIGHT: We’re using the Image Size dialog to resize the document and we’re mak-
ing sure that the Scale Styles setting is turned on.

We took a layer with a drop shadow 
applied (top) and turned that drop 
shadow into its own layer (bottom). 
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they’re independent of the layer they were originally attached to. You can then take 
those layers and apply different filters or effects to them. If the style was made of 
several different effects, each effect will appear as its own layer. 

Blending Options 

The first option within the Layer Effects menu is Blending Options. If you choose 
this, the Blending Options will appear and inside this dialog is a series of check 
boxes. Let’s look at how these settings can affect the layer styles. 

Blend Interior Effects as Group  When we say “interior effects,” we’re referring to 
effects that happen on the inside of the layer we’re working on. The Inner Shadow, 
Gradient Overlay and Color Overlay would be examples of interior effects. When 
we change the blending mode of a layer from Normal to something else (We used 
Multiply in the video example) and then apply an interior effect, that effect is going 
to ignore the blending mode and apply the change as if the blending mode were 
set to Normal. It will not apply the blending that you specified by changing the 
blending mode menu. If you would like the effect to acknowledge the blending 
mode, open the Blending Options and turn on the “Blend Interior Effects as Group” 
check box. This will combine the true contents of the layer along with any interior 
effects BEFORE the blending mode is applied. In other words, the layer styles are 
considered when we change the blending mode of the layer. 

At left, we applied 
a Gradient Overlay 
effect to a layer that 
had its blending 
mode set to Multi-
ply. In order for the 
blending mode to 
be recognized, we 
need to make sure 
the “Blend Interior 
Effects as Group” 
check box is turned 
on.
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Blend Clipped Layers as Group  When you clip a 
layer to the layer beneath it, it will only show up 
where there is content in that underlying layer. In 
the video example, we placed a photo layer on top 
of a shape layer and then clipped the photo layer 
to the shape layer. This made it so the photo only 
appeared within the shape. (To clip a layer to the 
layer beneath it, make sure the layer is active, go to 
the Layer menu and choose Create Clipping Mask.) 
The clipped layer will appear indented in the Layers panel and it will have a down-
ward-pointing arrow, pointing to the layer it’s clipped to. The “Blend Clipped Layers 
as Group” check box will determine whether it should combine the layers before 
it considers the blending mode of the underlying layer. When this check box is 
turned on, it will act as if the layers were first combined and then the blending 
mode was applied. In our example image, this will apply the blending mode to the 
photo layer contained within the shape layer. (The shape layer is the one with the 
blending mode applied.) Note that when working with this check box, you should 
have the underlying layer active, which is the one with the blending mode applied. 

The image layer above is clipped 
to the shape layer.

When the “Blend Clipped Layers as Group” check box is turned on, the clipped layer will re-
flect the blending mode that the underlying layer is set to.
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Transparency Shapes Layer This check box is turned on by default and it basically 
specifies that the transparency determines where the edge of the layer is. For ex-
ample, when you apply a layer style, like Bevel & Emboss, the style will be applied in 
the part of the layer where the pixels meet the transparent background. But what 
if you apply a layer style, like Bevel & Emboss, to an empty layer? Nothing would 
appear at all because the entire layer is transparent. There are no pixels meeting up 
with transparent areas that define the content of the layer. If you want to be able 
to apply the layer style to an empty layer, you can turn the “Transparency Shapes 
Layer” check box off. If you turn this setting off, then you will determine where the 
layer style should appear by painting on a layer mask attached to the layer. This 
way, you can have a completely empty layer, add a layer mask to it and then paint 
on the mask, therefore defining where the layer style should appear. 

When the “Transparency Shapes Layer” check box is turned on, the shape of the layer is 
defined by where there are pixels vs. where there is transparency.  When this check box is 
turned off, you can define where the layer styles should appear by painting on a layer mask, 
as we are doing above. 
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Layer Mask Hides Effects  In Photoshop, there is no way that we can have a layer 
positioned above another layer in one area but below it in another area. If we want 
to achieve this look, we will need to cheat a bit. We can take the overlying layer, add 
a layer mask and then paint with black on the mask in the area we want the layer 
to look as if it is positioned below the underlying layer. 

In the video example image, we have a metal clamp on one layer and we have a 
ruler on the layer above it. We’d like the ruler to look like it’s above the clamp on 
one side but below it on the other side. We’ll activate the ruler layer and add a layer 
mask. Then, we’ll hold down the command key (Ctrl on Win) and click on the clamp 
layer’s thumbnail in the Layers panel. This will create a selection around the clamp. 
With the ruler layer’s mask active, we’ll paint with black in the area where the right 
side of the ruler overlaps the right side of the clamp. Because we have a selection 
active, it will limit the area we’re applying paint to the area within the selection. This 
will prevent us from getting any overspray. Now we have masked the ruler layer so 
that it looks like the right side of the ruler appears under the clamp. 

We’ll now add a Drop Shadow 
layer style to the ruler layer. This 
creates a problem with our illu-
sion because the style is acting 
as if the edge of the ruler lay-
er is determined by the layer 
mask. It’s acting as if the hole in 
the mask were a hole in the lay-
er and applying the drop shad-
ow to reflect that. Basically, the 
layer mask is also masking the 
effects associated with the lay-
er. If we don’t want this to hap-
pen, we can go to the Blending 
Options and turn off the “Layer 
Mask Hides Effects” check box. 

A drop shadow was added to the masked ruler layer 
but the shadow was affected by the layer mask, de-
stroying the illusion. This is because the “Layer Mask 
Hides Effects” check box was turned on.
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When this check box is turned off, the layer mask will hide parts of the layer but 
the layer styles will stay the same. The mask will not have an effect on the styles. 

Vector Mask Hides Effects This check box works in the same way as the “Layer 
Mask Hides Effects” setting works, but instead of applying to a layer mask, it ap-
plies to a vector mask. 

The Background Layer

By default, you will not be able to apply any effects to the Background layer be-
cause it is locked. This is not a big deal, though. Know that you can unlock the 
background layer by clicking on the lock symbol to the right of the layer name or 
by simply double-clicking on the layer in the Layers panel. When you do this, the 
lock symbol will disappear and the name will change from “Background” to “Layer 
0.” Now, you can apply any effects that you’d like to this layer. 


